
XGT Panel, an HMI Device by LS Industrial System
Training Material on XP-Builder



Chapter 1| Overview of HMI ------------------------------------------------------------------------------------ 5

1. What is HMI? ----------------------------------------------------------------------------------- 6

2. Introduction of XGT Panel Product ----------------------------------------------------------- 7

3. XGT Panel Hardware --------------------------------------------------------------------------- 9

4. System Configuration -------------------------------------------------------------------------- 11

5. How to Communicate between HMI and Controller --------------------------------------- 12

Chapter 2| Executing XP-Builder--------------------------------------------------------------------------------- 16

1. Generating Project Using XP-Builder --------------------------------------------------------- 17

2. Generating and Configuring Basic Screen --------------------------------------------------- 19

Chapter 3| How to Communicate with PLC-------------------------------------------------------------------- 21

1. Configuring Communication between PLC and XGT Panel -------------------------------- 22

2. How to Send Drawing File from XP-Builder ------------------------------------------------- 24

3. How to Receive File from XP-Builder and Save it in the PC ------------------------------- 26

Chapter 4| System Menu and Execution Screen-------------------------------------------------------------- 28

1. Switching between System Menu Screen and Execution Screen on XGT Panel ---------- 29

2. XGT Panel System Menu ----------------------------------------------------------------------- 30

Chapter 5| Editing Toolbox and Shape-------------------------------------------------------------------------- 35

1. Editing Shape and Toolbox --------------------------------------------------------------------- 36

2. Practicing on Toolbox --------------------------------------------------------------------------- 41

Chapter 6| Monitoring Object-------------------------------------------------------------------------------------- 42

1. Bit Lamp ------------------------------------------------------------------------------------------- 43

2. Word Lamp ---------------------------------------------------------------------------------------- 46

3. N-phase Lamp ------------------------------------------------------------------------------------- 48

CONTENTS



4. Clock Object ----------------------------------------------------------------------------------- 49

5. Bit Message ------------------------------------------------------------------------------------ 52

6. Word Message -------------------------------------------------------------------------------- 53

Chapter 7| Control Object ------------------------------------------------------------------------------------- 54
1. Bit Switch -------------------------------------------------------------------------------------- 56
2. Word Switch ----------------------------------------------------------------------------------- 59

3. Screen Conversion Switch -------------------------------------------------------------------- 62

4. Special Switch ---------------------------------------------------------------------------------- 63

5. Multi-Function Switch ------------------------------------------------------------------------- 65

Chapter 8| Number & Letter Indicator/Editor ------------------------------------------------------------- 66

1. Number Indicator ----------------------------------------------------------------------------- 67

2. Number Editor --------------------------------------------------------------------------------- 69

3. Letter Indicator -------------------------------------------------------------------------------- 73

4. Letter Editor ------------------------------------------------------------------------------------ 75

Chapter 9| Windows, Parts, and Animations -------------------------------------------------------------- 78

1. Window Object ------------------------------------------------------------------------------- 79

2. Part Object ------------------------------------------------------------------------------------ 84

3. Animation Object ----------------------------------------------------------------------------- 89

Chapter 10| Graph ----------------------------------------------------------------------------------------------- 90

1. Bar Graph -------------------------------------------------------------------------------------- 91

2. Pie Graph -------------------------------------------------------------------------------------- 92

3. Meter Graph ----------------------------------------------------------------------------------- 93

4. Looped Curve Graph -------------------------------------------------------------------------- 94

5. Trend Graph ------------------------------------------------------------------------------------ 95

CONTENTS



Chapter 11| Special Functions ------------------------------------------------------------------------------- 97

1. Alarm ----------------------------------------------------------------------------------------- 98

2. Logging --------------------------------------------------------------------------------------- 105

3. Recipe ---------------------------------------------------------------------------------------- 116

4. Script ------------------------------------------------------------------------------------------ 121

Chapter 12| Convenience Functions ------------------------------------------------------------------------- 125

Annex | List of Special Devices ------------------------------------------------------------------------------ 132

CONTENTS



5



6

XGT Panel is a graphic control device that can monitor and control PLCs and controllers from different manufacturers 

including our company. You can use the edit tools to place various shapes and objects on the screen, configure their settings, 

and send them to XGT panel. By doing so, you can monitor or control the information on each controller as you have 

configured in the settings.

 A device that is designed to visually monitor the status of controlled facilities and issue commands when 

necessary.

 Its main purpose is monitoring and controlling facilities.

HMI (Human Machine Interface)

Chapter 1. Overview of HMI
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1) XP Specifications

Category XP30-BTE XP30-BTA XP30-TTE XP30-TTA XP40-TTE XP40-TTA XP50-TTA XP70-TTA XP80-TTA XP90-TTA

Display Element Mono Blue TFT Color LCD

Screen Size 14 cm (5.7”) 17.7 cm (7”) 21 cm (8.4”) 26 cm (10.4”) 31 cm (12.1”) 38 cm (15”)

Resolution 320 x 240 800 x 480 640 x 480 800 x 600 1024 x 768

Display Color 8-level grayscale 256 colors 65,536 colors

Backlight LED type

CCFL (LCD 

integrated), 

automatic 

On/Off 

supported

LED type CCFL (replaceable), automatic On/Off supported

Brightness 230 cd/㎡ 400 cd/㎡ 280 cd/㎡ 480 cd/㎡ 430 cd/㎡ 400 cd/㎡ 450 cd/㎡

Sound Magnetic buzzer

Operations LED Green: Normal, Red: Communication error, etc.

Memory

Flash 4 MB 10 MB 4 MB 10 MB 4 MB 10 MB 20 MB

Back-up 

RAM
128 KB 512 KB 128 KB 512 KB 128 KB 512 KB (saves log, recipe, and alarm data)

Communi

cations

Ethernet x 1 ch x 1 ch x 1 ch (10/100 Base-T)

USB Host 1 ch 2 ch 1 ch 2 ch 1 ch 2 ch (mouse, keyboard, and USB memory supported)

Serial RS-232C: 2 ch (1 ch for downloading drawing), RS-422/485: 1 ch

CF Card x 1 slot x 1 slot x 1 slot (Compact Flash)

Power DC 24 V DC 24 V / AC 100~220 V AC 100~220 V

Chapter 1. Overview of HMI
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Chapter 1. Overview of HMI

Name iXP70-TTA iXP80-TTA iXP90-TTA iXP70-TTM iXP80-TTM iXP90-TTM

Display

Screen Size 10.4" 12.1" 15” 10.4" 12.1" 15”

Display Device (Color) TFT Color (16,777,216 colors)

Backlight LED

Resolution
SVGA

(800X600)

SVGA

(800X600)

XGA

(1024X768)

SVGA

(800X600)

SVGA

(800X600)

XGA

(1024X768)

Brightness (cd) 700 550 800 700 550 800

Graphic Accelerator 2D accelerator integrated

Memory

System ROM (Flash) 1 GB (Screen 128 M)

System RAM (SDRAM) 512MB

Back-up RAM (SRAM) 1MB

Communicat

ions

Ethernet 10/100 Base-T

USB 2.0 Device 1 port (front)

RS-232C 1 ch (Flow Control Full signal, +5 V output)

RS-422/485 1 ch (block type)

External I/F

Expansion Interface 

Card
1 slot (Up to 3 cards can be layered)

CF Card, SD Card 1 slot each

USB 2.0 Host 3 ports (1 front, 2 rear)

VM Module 4 ch video input

Human Body Detection 

Sensor
Installed (Detects human body within 1 m)

Multimedia

Sound Output LINE-OUT 1 CH

Sound Input - LINE-IN/MIC (switched using the software)

Video Output - RGB 1CH

Video Input - Coaxial 1 CH

Playing Video Clip -
Recording: 640 X 480 30 fps

Playing: 1024 X 768 30 fps

Power
85 - 264 VAC (rated 110 V, 220 V)

DC 9.5 - 30 V (rated 12 V, 24 V)

2) iXP Specifications
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Bottom

Rear

CF card

USB port
Memory stick, 
keyboard, and 

mouse

Power

RS-232C

Dip switch

Ethernet

RS-232C
RS-422/485

PLC, INV

Economy model does not have an 
Ethernet port.

Expansion 
connector
Communication 
option board

1) XP Hardware

Switches for device settings

No. 1

No. 2

No. 3

No. 4

Not used

A

B

B

B

A

A

Normal operation (default setting)

Use watchdog function (default setting)

Used when updating Windows CE

Set RS-422/485 terminating resistor (120 Ω)

Do not use watchdog function

Do not use RS-422/485 terminating resistor

Switches for 
device settings
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2) iXP Hardware

Sensor

Detects human body within 1 m.

VM 
module 

connector

Option 
card 

connector

Video 
input port

Sound input 
port

Video output 
port

SD card Sound output 
portUSB Host 1ch

Connected to USB memory, mouse, and keyboard

USB 2.0 Device 

Used to send the screen data and update XP-Runtime

http://www.google.co.kr/imgres?imgurl=http://www.lanstore.co.kr/shop/upload/mall/c2276_lb.jpg&imgrefurl=http://www.lanstore.co.kr/shop/mall.php?cat=016003000&usg=__beKK9P9KlGtnmOJUu-NPLOjWxbA=&h=400&w=400&sz=81&hl=ko&start=3&zoom=1&tbnid=26xCS2G6dIqN1M:&tbnh=124&tbnw=124&ei=uKgzTcDSL5S6sAPjgJXBBQ&prev=/images?q=USB+%EC%BC%80%EC%9D%B4%EB%B8%94&hl=ko&newwindow=1&tbs=isch:1&itbs=1
http://www.google.co.kr/imgres?imgurl=http://www.lanstore.co.kr/shop/upload/mall/c2276_lb.jpg&imgrefurl=http://www.lanstore.co.kr/shop/mall.php?cat=016003000&usg=__beKK9P9KlGtnmOJUu-NPLOjWxbA=&h=400&w=400&sz=81&hl=ko&start=3&zoom=1&tbnid=26xCS2G6dIqN1M:&tbnh=124&tbnw=124&ei=uKgzTcDSL5S6sAPjgJXBBQ&prev=/images?q=USB+%EC%BC%80%EC%9D%B4%EB%B8%94&hl=ko&newwindow=1&tbs=isch:1&itbs=1
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XGK

XGT Panel

In order to operate the XGT Panel and controller, you should first send the drawing and PLC program using the PC.

After sending the drawing and PLC program using the PC, you can control and monitor the facilities through the 

communication between the panel and controller.

PC

1) Sending the drawing from PC to XGT Panel

Use the Ethernet cable and RS-232C cable to send the drawing project file from XP-Builder to XGT Panel.

※ Download using the RS-232C cable may take longer time. I recommend you use the Ethernet cable.

2) Sending the PLC ladder program from PC

Use the USB cable to send the ladder program to the program called XG5000.

Chapter 1. Overview of HMI

Serial/Ethernet
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One of the following three methods can be used to communicate between XGT Panel and controller:

Chapter 1. Overview of HMI

 CPU Communication
 CPU communication refers to the method that uses the loader port of the CPU module on the PLC for 

communication.

 Loader port on the CPU module is D-SUB 9P (female). A male connector should be used to make the cable.

 LINK Communication
 Serial (LINK) communication refers to the method that communicates with the communication module of PLC.

 Cnet can be classified into RS-232C port and RS 422/485 port.

 RS 422/485 port of PLC is composed of a terminal block. So it does not need a separate connector.

 Ethernet Communication
 Ethernet communication refers to the method that connects to the Ethernet card of PLC for communication.

CPU

Serial

Ethernet
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1) CPU Communication

 On the [Controller Settings], select the product whose name has LSIS: XGK (CPU) on it.

 RS232C is used for the CPU communication.

 Parameter settings are fixed in the CPU communication. So it does not require a separate configuration process.

For the CPU communication, you only need to set the communication controller in [Communication Device Settings]. If the 

communication does not work properly, check whether the cables are properly connected.
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2) LINK Communication

 On the [Controller Settings], select the product whose name has LSIS: XGK (LINK) on it.

 Select RS232C, RS485, or RS422 depending on the connection method you want.

 Press the [Detailed Connection Settings] and set the parameters (transmission speed and dialing code) to those of 

the PLC that you'd like to communicate with.

※ HMI generally works as a master. In the case of the dialing code, enter the code of the PLC that you wish to 

communicate with on the HMI.

Dialing code of 
the controller

Set the 
communication 
speed to that of 
the controller.
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3) Ethernet Communication

 On the [Controller Settings], select the product whose name has LSIS: XGK (ETHERNET) on it.

 On the [Detailed Connection Settings], enter the IP address of the PLC that you want to connect with.

※ HMI generally works as a client. In the case of the IP address, enter that of the PLC that you want to communicate 

with.

※ The [Use Expanded Protocol] option only supports TCP/IP.
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Chapter 2. Executing XP-Builder

In this chapter, you will learn how to execute XP-Builder and learn about the tools that constitute the screen.

1) Generating Project

 There are two ways to generate a project.

 One is to generate a project using the screen that appears first when you execute XP-Builder.

 The other is to generate a project by using the [New] menu on the [Project] tab.
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Chapter 2. Executing XP-Builder

Project

Screen Edit

Output

Tool

Execution Window

Window that is used to edit the 
screen before downloading it on 

the deviceWindow that is 
used to edit 
the overall 
screen of the 
project and 
add special 
functions

It is used to 
select an object 
or draw a 
shape.

This displays the error related to the drawing data and its details.

2) Description of Toolbar and Screen
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1) Generating Basic Screen

 Right-click the Basic Screen that is shown below to insert a screen. A new basic screen is generated.

 First number on the name of basic screen refers to the screen number.

 To change the screen name, right-click it and select [Rename].

In this chapter, you will learn to generate a basic screen and use various functions on the toolbox.

Screen Number

Chapter 2. Executing XP-Builder
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2) Changing Background Color
 Right-click the Edit window and select the [Properties]. Then, [Screen Registration Information] window appears.

 If you wish to change only the background color, check [Use Background Color] on the [Background] tab. Then, 

change the background color or foreground color.

 If you wish to insert an images on the background, check [Use Background Image] on the [Background] tab and 

press [Open] or [Library] button.

※ If you use a large background image for each screen, screen volume may become too large. I recommend you do 

not use background image too frequently.

Foreground color: Color of the pattern on the 
foreground
Background color: Background color of the screen

You can insert a pattern on the background using 
different foreground and background colors.

Chapter 2. Executing XP-Builder
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In this chapter, you will use the serial communication module of the XGK PLC and configure RS-232C 
communication with XP70.
Use the XG5000 and XP-Builder to configure the communication settings properly. First of all, check whether cable 
is properly connected between PLC, XGT Panel, and PC.

 Select [XG5000] → [Tools] → [Network Manager] to run XG-PD.

 Select [File] → [Open from PLC] on the XG-PD to read the parameter information of XGK PLC.

 XP works as a master and PLC works as a slave in the communication between XGT Panel and PLC. Therefore, be 

sure to set [Operation Mode] as 'XGT Server' when configuring the communication module of the PLC.

 Write down the parameters on the PLC using the [Online] → [Write Parameter] option. Then, be sure to perform 

reset by using [Online] → [Reset] option.

 This will conclude the PLC configuration process.

1) Configuration on the XG5000 (XG-PD)

Chapter 3. How to 
Communicate with PLC
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 Select [New] on the [XP-Builder] and the PLC device that will communicate with the XGT Panel you are using.

 Press the [Communication Device Settings] button and set the communications settings to those of the PLC 

settings.

 Insert a bit lamp on the basic screen and enter 'P0000' for device. Then, send the settings to the device.

 If the lamp appears on the XGT Panel, it means that the communication settings have been completed.

2) Configuration on XP-Builder

Chapter 3. How to 
Communicate with PLC
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There are several ways to send drawing files. However, it is quick and convenient to use an Ethernet cable or a USB memory.

 Connect the Ethernet cable between PC and XGT Panel. Then, execute the XP-Builder to open the project file 

you wish to send.

 Select [Communications] → [Send] menu on the XP-Builder.

 Press the [Connection Settings] button, select [Ethernet] and press the [Search] button. Then, select the IP 

address of the device that you wish to send the project file to.

 Press the [Send] button to send the project file to the device.

1) Sending File using Ethernet

Chapter 3. How to 
Communicate with PLC
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 Insert the USB memory on the PC. Execute XP-Builder and open the project file that you wish to send.

 Select [Communications] → [Send] menu on the XP-Builder.

 Select [Save on External Storage Device] and enter the name of the folder that you wish to store the 

downloaded project file.

 Press the [Send] button to send the project file to the USB memory.

 Insert the USB memory on the device and select [Project Download] on the [Storage Function] to download the 

drawing file.

2) Sending File using USB

Chapter 3. How to 
Communicate with PLC
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If you wish to receive a drawing file that is being used on the device, you should either use an Ethernet cable or a 
USB memory.

 Insert the USB memory on the device and select [Project Upload] on the [Storage Function] to upload the drawing 

file.

 When you insert the USB memory on the PC, you will see that the project.zip file is created in the folder named 

\XP_Backup.

 When you unzip the Project.zip file, you will see the project file that can be opened in the XP-Builder.

1) Uploading File using USB

Chapter 3. How to 
Communicate with PLC
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 Connect the Ethernet cable between PC and XGT Panel. Then, execute the XP-Builder and select [Communications] 

→ [Receive] menu.

 Press the [Connection Settings] button, select [Ethernet] and press the [Search] button. Then, select the IP address of 

the device that you wish to receive the project file from.

 Select the folder that you wish to save the project file. Then, press the [Receive] button to receive the project file and 

save it in the PC.

2) Uploading File using Ethernet

Chapter 3. How to 
Communicate with PLC
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There are two screens on XGT Panel. They are the system menu screen and the execution screen. System menu screen is used to 
change or check the settings of XGT Panel. Execution screen is used to operate and monitor the facilities by communicating with 
the controller.
You can switch between system menu screen and execution screen on the XGT Panel by performing as follows:

1) How to Switch from Execution Screen to Menu Screen

2) How to Switch from Menu Screen to Execution Screen

Press the empty space on the execution screen for more than 3 seconds to display the status bar at the bottom of the screen.
Press the button on right end of the status bar to move to the menu screen.

Press the [Start] button on the menu screen to move to the execution screen.

Chapter 4. System Menu and Execution Screen
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1) Touch Setting

If the XGT Panel does not recognize the location you touch, you can calibrate the touch markings on the XGT Panel. Press 
the [Touch Setting] → [Touch Calibration] button on the system menu screen to move to the Settings screen. If you press 
the middle of the + marking and then release it, the + marking moves to another location. You need to press 5 locations 
to finish the calibration of the touch markings on XGT Panel. If the XGT Panel does not recognize the location you touch, 
the touch function may not operate properly. So, be sure to move to the location that shows the + marking using the 
mouse and touch the + marking with a sharp-edged touch pen.

Screen that has the [Start] button is called the main menu. Screen that has the [Go to Main Menu] button is called the sub menu.
You can send the drawing file only when the XP displays the main menu or execution screen (not available on the sub menu).

Chapter 4. System Menu and Execution Screen
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Press the [Backlight Setting] button on the [System Configuration] screen to move to the settings screen. You can set 
the backlight auto turn off function so that the backlight turns off automatically when the user is away from the XGT 
Panel for a certain duration.

2) Backlight Setting

Press the [Date Time Setting] button on the [System Configuration] screen to set the date and time of XGT Panel.

3) Date Time Setting

You can also set the date and time on the [Clock] tab of the [View XGT Panel Information] menu on XP-Builder.

Chapter 4. System Menu and Execution Screen
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Press the [Ethernet Setting] button on the [System Configuration] screen to set the IP address for the Ethernet.

4) Ethernet Setting

Press the [Environment Setting] button on the [System Configuration] screen to set a shortcut to the execution 
screen and whether to use the buzzer.

5) Environment Setting

Press the [Disable] button and reboot the device if you don't want to use the Ethernet on the device. This 
increases the booting speed of the device. In order to use the Ethernet again, press the [Enable] button and 
reboot the device.

Chapter 4. System Menu and Execution Screen
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If you set the [Auto Go to Screen] option, the start screen appears automatically when you reboot the XGT Panel or 
complete downloading the edited data. If you deactivate this option, you may have to use the Start button on the main 
screen to move to the start screen.

If you set the [Quick Start] option, the start screen appears immediately without caching the images when you start the 
XGT Panel. Also, the progress bar does not appear. If you select this option, however, the screen you first enter may 
appear a little late. Especially, if the screen includes animation objects, it may take several seconds to load the screen 
depending on the images used. However, screen conversion speed becomes normal starting from the second screen.

If you set the [Hide Mouse Cursor] option, the mouse cursor does not appear after you switch the screen.

Use the [Buzzer On/Off] option to set whether to use the buzzer.

If you set the [Disable Menu Bar] option, the work window (menu bar) that is basically provided on the bottom of the 
screen does not appear. In this case, you need to draw and use a special switch to exit to the background screen.

You can set the background image using the [Set Background Image] button. Press the [Delete Background Image] button 
to remove the background image.

If you press the [Clear Data] button, all the files in the device that you downloaded will be deleted. However, if the 
password is set on the device, you should enter the password to delete the files. This password is needed, for example, 
when you download a project. You can set this password using the [View XGT Panel Information] option in the 
[Communications] menu of XP-Builder. Deleted files include all the data downloaded from user's PC such as user's 
project data, web server data, VNC starting module data, option card driver, RAPIEnet communication settings data, and 
XP-Manager settings data. However, the settings configured using the Environment Setting menu are maintained.

Chapter 4. System Menu and Execution Screen
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You can download or upload the drawing files and update the engine by using external storage devices such as CF card and 
USB memory. Touch the [Storage Function] option on the menu to display the dialog box as shown below.

6) Storage Function

If you touch the [Project Download] button, the dialog box as shown below appears. Select the USB or CF card that has 
drawing files, designate the list of files that you wish to download and press the [OK] button. Then, the drawing files are 
downloaded to the device.

If you wish to store the project back-up files in the device, you need to select the [Include Upload Project] option when you 
download the project.
Otherwise, the backup files are not stored in the device and, therefore, you cannot upload the project files from the device.

If you touch the [Project Upload] button, the dialog box as shown above appears. Select the USB or CF card where you want to 
store the drawing file and press the [OK] button. Then, the drawing files are uploaded to the folder named XP_Backup.

Chapter 4. System Menu and Execution Screen
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Chapter 5. Editing Toolbox and Shape

1) Drawing Shapes
 Straight line: Click on the two points and draw the straight 

line.

 Circular arc: Drag the mouse to make a circle. Then, form 

a circular arc by clicking on two points.

 Sector: Follow the same procedure as for drawing a 

circular arc. Circular arc only has the lines. However, the 

sector is filled with a color as well.

 Chord: It is used to draw an elliptical line.

 Multi-line: Click on the several points to link them.

 Polygon: Click on the several points to make a polygon.

 Ellipse: Drag on the mouse to make an ellipse.

 Quadrangle: Drag on the mouse to make a quadrangle.

 Round-cornered quadrangle: Drag on the mouse to make 

a quadrangle. Drag on the yellow point in the middle to 

adjust the roundness of the corner.

Objects that form the shapes and constitute the screen are located on the right side of the XP-Builder. This window has tools 

that are used to draw pictures or write letters. Select the shape that you wish to draw from the toolbox and click on the 

location where you wish to place it. Let's use these tools to draw a picture.

If you wish to change the properties of the shape, 
double-click on the shape to display the dialog 
box as shown above.

Sector, polygon, ellipse, quadrangle, and round-
cornered quadrangle
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Chapter 5. Editing Toolbox and Shape

2) Drawing Text

 You can use the tool to insert the text on the screen.

 Select the text and drag on the mouse to display the window where you can set the properties of the text.

 You can set the font, text color, text size, background color, text type, and width/height on the window.

 You can use all the fonts installed in your computer.

The text you 
enter here 
appears on the 
screen.

Check this option to use the text from [Text Table].

You can change 
the background 
color of the text.

You can change 
the color of the 
text.
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Chapter 5. Editing Toolbox and Shape

3) Inserting Picture

 You can use the tool to load graphic library or user graphic image on the screen.

 Click the [Picture] to display the graphic library window.

 Select the picture you want and drag on the screen. The picture appears on the screen.
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Chapter 5. Editing Toolbox and Shape

4) Generating User Library
 If you wish to use the picture or image stored in your computer for drawing, you should first add them to the 

user library.

 Type in a name for User Category and click on add button.

Ex.) ‘Personal Library’ is user category name

 Right-click to insert image.

 Select [Import] or [Export] to save the whole category as a file or to load it.

You can drag and drop it to the Execution screen

Save it as a  .xpg file
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Chapter 5. Editing Toolbox and Shape

5) Using Marking Tool

 You can use markings to divide the screen at a regular interval.

 Press [Marking] and drag on the screen to display a window as shown below.

 Adjust the color and interval of the markings

 If you disable small markings, it can be used as a table as shown in the Figure 1.

Figure 1)

Figure 2)
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Chapter 5. Editing Toolbox and Shape

Example 1.

Main Screen



Bit lamp, word lamp, N-phase lamp, clock, bit 
message, word message object

42
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Chapter 6. Monitoring Object

In this chapter, you will learn about the monitoring objects such as lamp, clock, and indicator that can monitor the facilities.

1) Creating Bit Lamp Object
 Click [Bit Lamp] in the [Object] window.

 Drag the mouse pointer on the edit window to match the size you want. Then, the window in which you can enter 

the device information appears.

2) General Settings
 [Default]: Enter the information of the device that the object will monitor.

You can either type the device information manually or select the device by pressing the icon next to the 

input window.
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Chapter 6. Monitoring Object

 [Display]: In this tab, you can select the shape and color of the lamp.

 [Text]: In this tab, you can set the text that appears depending on the lamp status.

[Use Original Image]

This option loads the image that was 
saved as a BMP file.

[Change Color/Pattern of the 
Image]

- This option loads the vector image.
- You can change the color as you 

desire.

Follow the same procedure as that 
used to set the text.
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Chapter 6. Monitoring Object

3) Expanded Settings

 [Offset]: The monitored device changes depending on the value of the offset device.

 We will learn more about offset after we learn about the functions of number indicator.

Button 1
HW0=1

Button 2
HW0=2

Button 3
HW0=3

Changes to P0001

Changes to P0002

Changes to P0003

Lamp Device

If the lamp device is P0 
and offset device set as HW0
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Chapter 6. Monitoring Object

This object monitors the value of the word device and shows different lamp images depending on its condition.

1) General - Default Settings
 Click [Word Lamp] in the [Object] window.

 Drag the mouse pointer on the edit window to match the size you want. 

Then, the window will show to enter the device information and conditional expression.

 Enter the device information of the word lamp. Then, enter the condition.

 Select the number of conditional expressions that you desire from AB (binomial) and ABC (trinomial).

 Press the [Operand] and set a fixed value or the standard device. Then, select the expression from the drop-down 

menu.

 If you want to check whether the expression is properly set, check on the blank space shown above.

 Standard device in the [Edit Range] window refers to the device (a) that you entered in the Word Lamp window.

※ Lamp does not appear on the XGT Panel if it does not communicate with the PLC.

(a)
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Chapter 6. Monitoring Object

2) General - Display/Text Settings

 Word lamp has the similar display settings as those of bit lamp. However, different images are displayed 

depending on the condition.

 In the Status field, you can set the image files for default value, condition 1, and condition 2 respectively.

 Select [Do not Use Image] if you don't want to use an image for the condition.

 You can set Do not Use, Slow, Normal, or Fast for the [Blink] option.

 You can follow the same procedure for the [Text] as you have done for the [Display].

3) General - Control

 You can configure the word lamp using the script.

 We will learn more about script in a later chapter.
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N-state lamp is used to monitor different statuses based on the combination of bits.

1) Configuring N-state Lamp

 Create an N-state lamp on the screen.

 Set the number of conditions to 4 in the [Default] option.

 Designate [Change Status Based on Bit Combinations] for 

[Status Change Method].

 Designate images for conditions 0, 1, 2, and 3 in the [Display] option.

 Follow the same procedure for [Text] as you have done for [Display].

2) Changing status based on bits/Changing status based on bit combinations

 Changing status based on bits

Category P0 P1 P2 P3 Display

Status 1 0 0 0 0

Status 2 1 0 0 0

Status 3 0 1 0 0

Status 4 0 0 1 0

Status 5 0 0 0 1

Category P0 P1 P2 P3 Display

Status 1 0 0 0 0

Status 2 1 0 0 0

Status 3 0 1 0 0

Status 4 1 1 0 0

Status 5 0 0 1 0

 Changing status based on bit combinations



49

Chapter 6. Monitoring Object

1) General - Default Settings
 You can set the display type of the clock.

 Select display type, date format, and time format from each drop-down list.

 Check [Display Day] to display the day of the week next to the date and time.

 Check [Fill with 0] to fill the blank area with 0.

 You can check the display format in [Preview].

 You can set [System Time] or [Logging Trend Time] from the [Type of Time].

 [Logging Trend Time] shows the latest time, oldest time, and the time at cursor location for the logging trend.

2) General - Display/Text Settings
 You can press [Library] or [Open] button in the [Display] option to set the image that you want to use as 

background image for the clock.

 Select [Do not Use Image] to use a transparent background.

 You can set the color and font of the clock in the [Text] option.

Clock object shows date/time of the XGT Panel or the latest time, oldest time, and the time at cursor location for the logging 

trend.
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Chapter 6. Monitoring Object

3) Expanded Settings

 [Display Trigger] is used to display the object when it has satisfied all the conditions for the device.

 [On Bit]: Displays the clock when the entered device is On.

 [Off Bit]: Displays the clock when the entered device is Off.

 [Range]: Displays the clock when the value entered for the device belongs to the set range.

 [Multiple Bit]: Displays the clock when several bit conditions are met.
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Chapter 6. Monitoring Object

1) Viewing XGT Panel Information
 Click [Communications] → [View XGT Panel Information] to display the window where you can see the 

information on XGT Panel.

 Press the [General] tab in the window to see information such as operational status and memory usage.

2) Synchronizing Time

 Press the [Clock] tab. Then, you will see the buttons that can be used to enter date or to synchronize with the 

system time.

 To synchronize time, however, the XGT Panel should be connected to the computer.

3) Setting Password

 If you set password on this window, you will have to enter the password every time you send or receive a drawing.

4) Installing USB Driver

 USB communication is supported for XP-Builder version 1.24 or higher. Therefore, you need to install the USB 

driver.

 Press the [Install/Update XGT Panel Driver] - [Settings] button in the [Settings] tab to start the installation.

On the [View XGT Panel Information] window, you can synchronize the time of XGT Panel with that of PC, set the password 

for downloading/uploading the drawing, install USB driver, and see the information on XGT Panel.
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Message object is used to display text on the text table according to the value of the device. To use a message object, you 

should first register the text table.

1) Registering Text Table

 Double-click on [Insert Text Table] or Right-click 

[Text Table] in the [Project] window to add text table.

 Enter the text in the text string you created.

 Properties of the text can be adjusted using [Color], 

[Italic], [Underscore], [Strikethrough], and [Bold] options.

2) Setting Bit Message

 Enter the bit device information in [Basic].

 Change the image in [Display].

 Press the text table in [Text]. 

Then, enter the text according to the ON/OFF condition.

Chapter 6. Monitoring Object
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Word message shows different messages based on the value of word device. You can set the word message as follows:

1) Setting Word Message Object

 Enter the word device information in [Basic].

 If you select Indirect, different messages that are registered in 

the text table appear depending on the value of word device.

 In the case of Status, different text appears depending on the 

condition set in [Case] tab.

 Change the image in [Display].

 Select the text you wish to display in [Text] to display the text.

 [Case] option appears only when you selected Case in the 

[Basic] tab.

 Press the folder icon above to display the window where you 

can enter the condition.

 Press the text table to select the text to be displayed when the 

condition is met.

Chapter 6. Monitoring Object
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Chapter 7. Control Object

In this chapter, you will learn about switch objects that are used to control facilities. There are five types of switches: bit,

word, screen conversion, special, and multiple switches. Each switch object not only controls the device in the controller, but 

also monitors it.

Before we learn about switch objects, we will briefly look at operating principle of controller.

Things to Note!

Operating Sequence of PLC CPU

 You cannot control the P area, which is the actual IO device area, 

using a switch in the XP. This is because the CPU in the PLC operates 

by repeating the sequence indicated on the left.

 When you issue ON/OFF signals using a switch in the XP, you are only 

writing the values in the device memory through data communication, 

not sending an electric signal to actual IO device. CPU in the PLC 

reads the electric signals of the actual IO device every time it is 

scanned and applies the values in the device memory. So, the values 

that are written in the XP through data communication are 

overwritten by the CPU immediately.

 Therefore, you should not use the address of the actual IO device as 

control device for the switch.

Input Scan

Write on Memory

Execute Scan 
Program

Write Output on 
Memory

Output
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1) General Settings
 [Basic]: You can enter the device that you want to control using the switch and the device for the lamp condition.

 Detailed settings include On/Off/Momentary/Alternative

 The On/Off option only produces the output corresponding to the current status when the switch is pressed.

 Momentary: The controller turns ON only when you press the switch. It turns OFF if you release the switch.

 Alternative: The controller turns ON when you press once, OFF when you press once more. This option produces 

the output that is opposite to the current status of the device.

2) Lamp Condition Settings
 The switch monitors the device that is entered in the lamp condition and displays its ON/OFF status.

 You can set the lamp condition using the bit value as well as the word value range.

Bit switch controls ON/OFF status of the controller. If you use the switch with a lamp condition, you can both control and 

monitor the device at the same time.

Lamp Condition - Bit Lamp Condition - Word
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3) Detail - Security Level

 You can set security level for each switch.

 You can set password for the security level in the [Project Properties] - [Security Settings].

 User who knows level 9 password can operate all switches from level 1 to 9.

 User who knows level 1 password can only operate level 1 switch.

 If you enter the security level duration, the password is deactivated for the set duration once you enter the password.

 If you set the security level duration to 0, you have to enter password every time you press the switch.

 Check [Detail] - [Security Level] in the switch to set the security level of switch.
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Chapter 7. Control Object

4) Detail - Delayed Operation

 Operation after Delay: It operates only after you press the switch for the set duration.

 Operation, Delay and Return: This option is available only when the switch setting is ON/OFF.

 Generally, when you turn ON the switch, it does not turn OFF until you press the OFF button. However, if you 

set the duration in the [Operation, Delay and Return] option, the switch turns OFF automatically after the set 

duration.

 Double Check: If you press the switch, a window appears asking for confirmation.

5) Detail - Offset during Writing

 If you set device for this option, the device address for the switch changes depending on the value of the 

device.

Default device Value of offset device

Ex) value-> 3

HX0003
Changes to the switch of the device

It operates when you press the switch for 2 seconds.

The switch returns to the original condition 2 seconds after 
operation.

This window appears when you 
selected [Double Check].

a
b

Ex) HX0000
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1) General Settings
 [Write Value], [Add Value], and [Subtract Value]: By pressing the switch, you can write, add, or subtract a fixed 

value or a value of another device to/from the standard device on the controller.

 [Script]: By pressing the switch, you can perform a script once.

 [Increase/Decrease Value of a Certain Digit]: You can add or subtract a value 

to/from a certain digit.

Only HEX or BCD numbers are supported.

2) Lamp Condition
 Lamp condition for the word switch can be entered in the detail option.

Switch is divided into bit switch and word switch just like a lamp. Therefore, type of object that is used also varies depending

on the device type. Word switch can control word device. Types of word switch operation include write, add, subtract, script,

and increase/decrease the value of a certain digit.

Second digit

First digit



60

Draw the example shown below.

[Description of Screen Actions]

(1) If you press "Button 1" in the Incoming screen, "Button 1" turns ON. If you press the [START] button, "Button 1" turns 

OFF and "NO. 1" block blinks.

(2) "Button 2" to "Button 6" in the Incoming screen operate in the same way as "Button 1".

(3) If you press "Button 1" in Outgoing screen, "Button 1" turns ON. If you press the [START] button, "Button 1" and "NO. 

1" block turn OFF.

(4) "Button 2" to "Button 6" in the Outgoing screen operate in the same way as "Button 1".

• Draw it using the offset functions of the switches.

• Draw it using several switches and operating conditions.

IN Out

Chapter 7. Control Object
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Draw the example shown below.

[Description of Screen Actions]

(1) If you click the IN button, background color changes to yellow-green. (OUT button is reset.)

(2) If you click the IN button and No. 1 button, background color of No. 1 lamp blinks in red. (IN button is reset.)

(3) No. 2 to No. 5 buttons operate in the same manner.

(4) If you click the OUT button, background color changes to yellow-green. (IN button is reset.)

(5) If you click the OUT button and No. 1 button, No. 1 lamp is reset. (OUT button is reset.)

(6) No. 2 to No. 5 buttons operate in the same manner.

•Use the operating conditions of the switches.

•Use two switches in one position for drawing.

lamp lamp ButtonButton

Chapter 7. Control Object
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Chapter 7. Control Object

1) Screen Conversion Switch

 [Screen Type]: You can switch between default screen and global window screens as well as between global 

window screens.

 Screen switching using device: Screen is switched depending on the value entered in the device.

 Fixed: By pressing the switch, you can move to the screen that matches the number you have entered.

 Previous Screen: You can move to the previous screen regardless of the screen number you have entered.

2) Screen Switching Using Device

 Enter [Screen Conversion Device] in the [Project Properties] - [Screen Settings] to switch to the screen that matches 

the number you have entered in the device.

There are two ways you can switch between screens. One is to use the screen conversion switch and the other is to set the 

device in the Project Properties. In the latter case, the screen is switched depending on the number that is entered in the device.
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1) Language Conversion

 You can enter the text in different languages using 

the text table.

 Right-click the text table to select a language in 

[Properties].

 Select the language you wish to convert to in the 

[Special Switch] - [Language Conversion] option in 

the execution screen.

2) End Operation

 If you wish to exit to the system menu in the XGT 

Panel, you can press the End Operation button.

3) Print Screen

 You can capture the current screen and save it in the 

USB memory or CF card.

4) Close Pop-up Window

 You can use this function to close the window 

displayed on the execution screen.

The switch is not controlled by the device, but by advanced functions such as alarm, logging, and language conversion. You 

can set the function of the switch in the [Type of Special Switch] tab. At the moment, we will only look into a few functions

of special switch. We will learn more about advanced functions in a later chapter.

Alarm, 
logging
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The Generate Text Table Automatically function is used to automatically add the text entered in the shape or object to the 

text table. You may use this function to add the text of a drawing file created in one language to the text table to support 

localization into different languages.

Select ‘Register object caption to TextTable
automatically' in the [Tools] menu.

• Add all static text used in the object to the text table.

• You can add up to 10,000 text strings to the text table. You can designate the name and language for the 
new text table.

Chapter 7. Control Object
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1) Type of Operations

 You can add up to 20 operations.

 The operations are performed sequentially from top to bottom.

 Screen conversion switch is always located at the bottom.

2) Script Performed when Pressed or Released

 You can use this function to execute the script when you press or release the switch.

You can use this switch to operate several functions at the same time with one switch.

Select an option to use it.

You can edit the operating sequence 
using arrows and the Delete button.

Korean
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Number indicator is an object that reads the designated device value and displays the value on the screen in the 
preset format.

Chapter 8. Number & Letter Indicator/Editor

1) Default Setting

 Enter the device that you wish to display on the screen in [Device]. Then, select the size or format of the number.

 When you display the decimal points, enter the number of digits in [Number of Digits]. Then, enter the number 

of digits to the right of the decimal point in [Number of Fractional Digits]. For example, if you enter 1234.5, 

[Number of Digits] will be '5' and [Number of Fractional Digits] will be '1'.

 [Text Type] is used to add a unit or text to the number. Here, the number is indicated as '*'. For example, if you 

enter 123.45 kW, you have to enter ***.** kW.

 Scaling automatically scales the data value of PLC and displays it in the panel. Here, maximum/minimum value 

of the device refers to the value in the controller, while maximum/minimum output value refers to the value in 

the panel.

For example, if the PLC sends the values between 0 - 20 and the values between 0 - 16000 are displayed in the 

panel, 10 coming from PLC is automatically converted and displayed as 8000 in the panel.
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2) Display and Text

 If you want to change the background of the number, you can 

adjust it in [Display]. If you want to use the transparent 

background instead of using an image, you can check the 

[Transparent BG Image] option.

 You can adjust the font, size, and color of the text used in the 

number indicator in [Text].

3) Setting Display Condition

 You can use the number indicator to display a value 

in the preset format if the value satisfies the 

conditions set by the user.

 For example, if the standard device is higher than 0 

and lower than 500 (0<$V<500), numbers from 1 to 

499 are displayed in the preset text and background 

colors.
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Just like a number indicator, a number editor monitors the value of device when displayed in the XGT Panel. 
However, when it is in the input mode, you can enter a value in the controller using the number editor.

Chapter 8. Number & Letter Indicator/Editor

1) Default Setting

 Enter the device in which you wish to enter a value in [Device]. 

Then, select the size or format of the number.

 When you display the decimal points, enter the number of digits 

in [Number of Digits]. Then, enter the number of digits to the 

right of the decimal point in [Number of Fractional Digits]. For 

example, if you enter 1234.5, [Number of Digits] will be '5' and 

[Number of Fractional Digits] will be '1'.

 Scaling automatically scales the data value that is written in the 

panel and enters it in the PLC. Here, maximum/minimum value of 

the device refers to the value in the controller, while 

maximum/minimum input value refers to the value in the panel.

 If you check [Use Password], numbers are displayed as '*' when 

they are entered, preventing others from seeing the numbers.

2) Setting Input Condition

 You can set the input condition and prevent numbers that do not 

match the condition from being entered in the editor.

 As you have done for the display conditions of the number 

indicator, you can set the input condition by setting the number 

range.
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You can use the number editor to enter a number so that it can be written or displayed in the controller.

Chapter 8. Number & Letter Indicator/Editor

3) Expanded Settings - Details

 Security Level: You can set a password on the number editor, allowing you to change the device value only when 

the correct password is entered. User who knows level 9 password can enter value in all number editors from 

level 1 to 9. However, user who only knows level 1 password can only enter value in the level 1 number editor.

 You can set password in [Project Properties] - [Security Settings].

 [Security Level Duration] refers to the duration for which the password is deactivated once you enter the 

password.

 You can set the value as 0 to require the password whenever you open the number editor.

 Write-Checking Device: You can use this device to check whether the value entered using the number editor is 

properly written in the controller. The write-checking device is commonly used when you want to perform 

additional actions in the controller after you change the data in the controller through the HMI.

 Writing Device Return refers to the duration for which the device waits before being turned off automatically 

after the number input is complete.
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You can use the number editor to enter a number so that it can be written or displayed in the controller.

Chapter 8. Number & Letter Indicator/Editor

4) Expanded Settings - Keypad Settings

 Input Method: Input methods can be divided into [Touch] and [Input Device]. [Touch] is a function that switches 

to the input mode whenever the number editor is pressed. [Input Device] is a function that switches to the input 

mode when the input device is turned ON.

 Clear Type: Select [Auto Clear OFF] to maintain the previous value when the input mode is activated. If you wish 

to clear the value to 0, select [Auto Clear ON].

 Use Keypad Window: Check this option if you want the keypad to appear automatically when the input mode is 

activated. If you uncheck this option, the keypad does not pop up even if you press the number editor. In this 

case, you need to place the keypad on the screen.

 If you designate the keypad number, you can bring up the keypad that you have created in the Windows screen.

 Use Auto Cursor: Unlike the case where the input mode is activated only when you touch the input editor in the 

panel, you can use the Auto Cursor function to make the next number editor is activated automatically once the 

input is complete in the previous editor. Keypad also moves in the preset order automatically.

 Use Interlock (Input is prohibited): You can prevent the input depending on the status of the device. If the 

interlocked device meets the preset condition, the input mode is deactivated completely.
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You can use the number editor to enter a number so that it can be written or displayed in the controller.

Chapter 8. Number & Letter Indicator/Editor

5) Expanded Settings - Operating Conditions

 If you use this option, the value is entered only when the 

conditions of the device are met.

 On Bit: The value is written when the device is On.

 Off Bit: The value is written when the device is Off.

 Range: The value is written only when the preset 

condition is met.

 Multiple Bit: The value is written only when the preset bit 

combinations are met.

6) Expanded Settings - Display Trigger

 The number in the number editor is displayed only when 

the conditions of the device are met.

 On Bit: The value is displayed when the device is On.

 Off Bit: The value is displayed when the device is Off.

 Range: The value is displayed only when the preset 

condition is met.

 Multiple Bit: The value is displayed only when the preset 

bit combinations are met.
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Letter indicator displays the letter in the device depending on the entered value.

Chapter 8. Number & Letter Indicator/Editor

1) General

 Letter is displayed in the device depending on the entered value. Displayed letters use the ASCII table.

 Letter indicator may look different depending on the display type.

 Device Value: It displays the letter depending on the device value.

 Current Input Value: It displays the value entered in the keypad on the current window.

 Current Maximum/Minimum Values: It displays the maximum/minimum values that can be entered in the number 

editor that you have selected.

 Maximum/Minimum values are often displayed in the window and used together with the keypad.
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Letter indicator displays the letter in the device depending on the entered value.

Chapter 8. Number & Letter Indicator/Editor

2) Expanded Settings

 [Details] - [Offset]: Device of the letter indicator changes depending on the value entered in the device.

 [Display Trigger]: It displays the letter depending on the preset condition.

 The text in the letter indicator is displayed only when the conditions of the device are met.

 On Bit: The letter is displayed when the device is On.

 Off Bit: The letter is displayed when the device is Off.

 Range: The letter is displayed only when the preset condition is met.

 Multiple Bit: The letter is displayed only when the preset bit combinations are met.
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Letter editor is used to enter a letter in the device depending on the entered value.

Chapter 8. Number & Letter Indicator/Editor

1) General

 Enter the ASCII letters in the device. Just like the letter indicator, entered letters use the ASCII table. You can 

enter the letter in the unit of word. Letter that is entered first is stored in the lowest byte of the target device. 

Letter that is entered last is stored in the highest byte of the target device.

 Enter the device and designate the number of bytes that you wish to enter. Then, enter the letter.

 [Use Data Byte Swap]: The letter is entered in the input address in the unit of word. If you enter 'ABCD' and 

apply Byte Swap, it is entered in 'BADC'.

 [Encryption]: When you enter the letters, they are indicated as '*'.
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4) Expanded Settings - Keypad Option

 Input Method: Input methods can be divided into [Touch] and [Input Device]. [Touch] is a function that switches 

to the input mode whenever the number editor is pressed. [Input Device] is a function that switches to the input 

mode when the input device is turned ON.

 Clear Type: Select [Auto Clear OFF] to maintain the previous value when the input mode is activated. If you wish 

to clear the value to 0, select [Auto Clear ON].

 Use Keypad Window: Check this option if you want the keypad to appear automatically when the input mode is 

activated. If it is unchecked, the keypad does not pop up even if you press the number editor. In this case, you 

need to place the keypad on the screen.

 If you designate the keypad number, you can bring up the keypad that you have created in the Windows screen.

 Use Auto Cursor: Unlike the case where the input mode is activated only when you touch the input editor in the 

panel, you can use the Auto Cursor function to make the next number editor is activated automatically once the 

input is complete in the previous editor. Keypad also moves in the preset order automatically.

 Use Interlock (Input is prohibited): You can prevent the input depending on the status of the device. If the 

interlocked device meets the preset condition, the input mode is deactivated completely.

Letter editor is used to enter a letter in the device depending on the entered value.
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Chapter 8. Number & Letter Indicator/Editor

3) Expanded Settings - Operating Conditions

 The letter editor operates when the preset conditions of 

the device are met.

 On Bit: The value is written when the device is On.

 Off Bit: The value is written when the device is Off.

 Range: The value is written only when the preset 

condition is met.

 Multiple Bit: The value is written only when the preset bit 

combinations are met.

4) Expanded Settings – Display Trigger

 The text in the letter editor is displayed only when the 

conditions of the device are met.

 On Bit: The value is displayed when the device is On.

 Off Bit: The value is displayed when the device is Off.

 Range: The value is displayed only when the preset 

condition is met.

 Multiple Bit: The value is displayed only when the preset 

bit combinations are met.

Letter editor is used to enter a letter in the device depending on the entered value.
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Window object is used to call a window on the basic screen. There are bit and word windows.
A window appears on the basic screen as an overlapped window or as a pop-up at a time the user wants.

You need a window to use bit windows. First, create a new window in the Window menu of the project window.

Change the background color as you wish in the Screen Properties window. If you bring the mouse to the 

bottom right side of the screen, an arrow appears, allowing you to adjust the size of the window. You can adjust 

its size by dragging the arrow.

In order to call the window on the basic screen, add a bit window object to the basic screen.

1) Bit Window

Chapter 9. Windows, Parts, and Animations
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Enter the bit device in the Device menu to call the window. Then, select the number of window that you want.

Bit condition is the bit status that is used to call a window on the basic screen. If you select On, the window appears 

on the basic screen when the device value is On. The window disappears from the screen when the device value is Off.

A window can be either a pop-up or an overlapped window. A pop-up looks like a dialog box. The portion of the 

basic screen located below the pop-up window is not displayed. A pop-up appears at the top layer of the screen on 

top of any other objects or shapes. It has an outside frame and can be moved within the screen.

An overlapped window appears overlapped on top of the basic screen. The portion of the window where no shape or 

object is drawn is transparent, displaying the basic screen underneath. An overlapped window cannot be moved and 

does not have an outside frame. It is called on the layer where the window is generated.

Chapter 9. Windows, Parts, and Animations
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The Alignment menu sets the alignment criteria for the window and bit window object. The window start 

position and bit object position are aligned.

You can choose an alignment position you want, including center, top left, top right, bottom right, or bottom 

left.

Chapter 9. Windows, Parts, and Animations
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In the case of word window, a window is called that matches the range of word device value or the word device value 

itself.

Word window can be categorized into [Indirect] and [Case]. If you select [Indirect], a window that matches the device 

value is called on the designated location according to the value of the word device.

If you select [Case], you can set the conditions on the [Case] tab of the word window object. A window is called when 

the conditions are met.

2) Word Window

Chapter 9. Windows, Parts, and Animations
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Practice) Let's write a program where a bit window appears asking for a Yes/No input when you press the bit 

switch so that you can control a bit device (M000).

1) Depending on the status of the M000 device, the bit switch displays an ON or OFF image.

2) When you press the bit switch, a message that says "Are you sure you want to operate it?" appears on the 

window if the M000 device is OFF. If you press [Yes], the window closes and the ON command is issued. If 

you press [No], only the window closes.

3) When you press the bit switch, a message that says "Are you sure you want to stop it?" appears on the 

window if the M000 device is ON. If you press [Yes], the window closes and the OFF command is issued. If 

you press [No], only the window closes.
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Part object is used to call a part (auxiliary screen) on the basic screen. There are bit and word parts.
Part object is used to move or change a shape (including image) on the basic screen. It is also used to add animation effect 
to the image (fan or motor). You can only draw shapes and images on the auxiliary screen. An object cannot be inserted on 
the screen. If you place a shape or image on the auxiliary screen, only the shape or image is displayed on the auxiliary screen 
and the rest of the area is transparent when the auxiliary screen is called on the basic screen.

You need an auxiliary screen to use bit parts. First, create a new auxiliary window in the Auxiliary Window menu of the 

project window.

Select the Picture menu in the Toolbox on the auxiliary screen. Then, bring the picture of a torch as shown below. Add 

another auxiliary screen and insert a different torch of the same size. You can give animation effect to the part by showing 

the two auxiliary screens alternately.

1) Bit Part
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Open the basic screen and select a bit part. Then, place the bit part on the screen. You can use a part object to call an 

auxiliary screen on the designated location. You can also allow the pictures on the auxiliary screen to be moved on 

the basic screen.

Set the movement type as [Fixed] and designate the device as HS000.6 (200 ms ON/OFF timer) as shown below. Then, 

enter the numbers of auxiliary screens used when the device is turned ON/OFF. Send the settings to the device and 

you can see the image of a burning torch.
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Next, we are going to practice on the movement type of bit parts. Open the basic screen and select a bit part. Then, 

place the bit part on the screen. Set the movement type as [Coordinate] and designate the device as HS000.6 (200 ms 

ON/OFF timer) as shown below. Then, enter the numbers of auxiliary screens used when the device is turned ON/OFF.

If you enter D0000 in the Device field under the Location menu, D0000 is set as X-coordinate and D0001 is set as Y-

coordinate automatically. Now, this part object moves on the screen according to the D0000 (X-coordinate) and D0001 

(Y-coordinate) values of the device.

Origin (0, 0) is at top left side of the screen. X value increases as the object moves to the right on the X-axis and the Y 

value increases as the object moves down on the Y-axis. XGT Panel has different resolutions depending on the device. 

So, the maximum/minimum values on the X/Y axes may differ depending on the device.

If you select Straight Line as movement type, the part object moves along the straight line that is drawn on the screen 

according to the location device value. You can designate the maximum/minimum values as you wish.

If you select Path as movement type, the part object moves along the points that you selected according to the location 

device value.
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Moving Along the Straight Line

Moving Along the Path
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There are different movement types for word parts as well. You can move the part according to the location device value.

Bit parts can only call two auxiliary screens depending on the conditions. But word parts can call more than two auxiliary 

screens.

Word parts can also call an image file that is saved in external storage device (CF card or USB memory) according to the 

conditions of word device.

2) Word Part

In the case of word part, an auxiliary screen is called that matches the range of word device value or the word device 

value itself.

Word part can be categorized into [Indirect] and [Case]. If you select [Indirect], an auxiliary screen that matches the 

device value is called on the designated location according to the value of the word device.

If you select [Case], you can set the conditions on the [Case] tab of the word part object. An auxiliary screen is called 

when the conditions are met.
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If you select the Repeat option, you can make the image move continuously regardless of the status of bit device.

If you enter a bit device address at the Start/End field, the animation is activated when the bit is ON and deactivated 

when the bit is OFF.

You can also specify the Stop/Resume action and animation speed.

You can use different image file formats (bmp, jpg, wmf, gif, etc.) for drawing in XGT Panel. Among them, animation 

gif files can be used to show the movement of a fan or motor. You can use not only the animation gif files that are 

stored in the graphic library, but also any gif files that the user has to give an animation effect.
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Graph object displays the device values in different graphs. There are various types of graphs: bar, pie, meter, 
looped curve, trend, logging trend, and distribution graphs.

Create a bar graph on the screen and set the device address that 

you would like to refer to on [Basic].

Use a fixed value or device value to designate the 

maximum/minimum values in the [Max./Min. Value] menu.

Set the fill color, pattern color, and default markings for the bar 

graph in the [Display] menu.

Enter the conditions in the [Case] field to display the color you 

desire on the graph when the conditions are met.

1. Bar graph - Displays the value of word device in the shape of a bar within the range of 
maximum/minimum values.
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Create a pie graph on the screen and set the device address 

that you would like to refer to on [Basic].

Use a fixed value or device value to designate the 

maximum/minimum values in the [Maximum/Minimum Value] 

menu.

Percentage is calculated as (Device value - Minimum 

value)/(Maximum value - Minimum value) * 100.

Set the shape, direction, fill color, pattern color, and default 

markings for the pie graph in the [Display] menu.

Enter the conditions in the [Case] field to display the color you 

desire on the graph when the conditions are met.

2. Pie Graph - Displays the area (%) that the value of word device takes up in the shape of a pie.
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Create a meter graph on the screen and set the device address 

that you would like to refer to on [Target Device].

Use a fixed value or device value to designate the 

maximum/minimum values in the [Max./Min. Value] menu.

Percentage is calculated as (Device value - Minimum 

value)/(Maximum value - Minimum value) * 100.

Set the shape, direction, needle color, and default markings for 

the meter graph in the [Display] menu.

Enter the conditions in the [Conditions] field to display the 

color you desire on the graph when the conditions are met.

3. Meter Graph - Displays the value of word device as a needle in the circular arc gauge.
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You can create a looped curve graph in an oval or polygon 

shape. Create a graph on the screen and set the device 

address that you would like to refer to on [Target Device].

Use a fixed value or device value to designate the max./min. 

values in the [Maximum/Minimum Value] menu.

Set the fill color, pattern color, and default markings for the 

graph in the [Display] menu.

Enter the conditions in the [Case] field to display the color 

you desire on the graph when the conditions are met.

4. Looped Curve Graph – Displays the value of word device in a looped oval shape or other looped shape that 
cannot be represented in a bar or circle. You can create a looped curve in an oval or polygon shape.
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You can add up to 8 devices in one trend graph and monitor 

the trend in a broken line. Enter the address of the devices 

that you wish to monitor next to the corresponding number. 

Then, set the line color and shape for each device differently.

Use a fixed value or device value to designate the 

maximum/minimum values in the [Maximum/Minimum Value] 

menu for the Y-axis.

Use a fixed value or device value to designate the warning 

values in the [Warning Values] menu for the Y-axis. Once you 

set the colors for highest/lowest values for warning, the 

graph changes to the corresponding color when the device 

value exceeds the range set by highest/lowest values.

5. Trend Graph – Collects the values of word device in a regular interval and connects each value with a straight 
line. The values of word device are represented in a broken line so that you can easily see the trend of data.

You can set the number of areas you wish to divide the X-axis 

(time axis) into in the [Number of X-axis Areas] field. This number 

determines the time range where the device can be monitored in 

the X-axis.

You can set how much you would like to shift the graph to the 

left when the line is drawn to the end of the X-axis in the [Data 

Movement Unit] option.

[Acquisition Cycle] is the interval with which you refresh the 

graph.

You can set the number and color of markings.
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 You can add reference lines with which you can check 

the Y-axis value of a certain point in the graph by 

setting the [Use Reference Line] option.
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There are three types of alarms that are provided by XGT Panel: system alarm, flow alarm, and history alarm. 

System alarms are preset on the XGT Panel to indicate alarms that can occur while the system is operating.

1) System Alarm - Double-click the System Alarm option on the project window to see the list of system alarms as shown 

below. When the system alarm occurs, the red LED turns on in the XGT Panel. To check the details of the alarm, select 

[Project Properties] → [Auxiliary Settings] → [Alarm window pop-up]. Then, the details of the system alarm appear in a 

pop-up window on the execution screen when the alarm occurs.
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Enter the number of devices to be monitored on the Flow Alarm Settings panel to display the list of alarms below. 

Enter the bit device that you want to set as an alarm in the list. Enter the text table and number to register the 

message corresponding to the alarm device.

You can check the number of current alarms by assigning it to a device.

When a flow alarm occurs, designate the background color of the message and position where the flow alarm will 

be displayed.

You can adjust the display speed of the message by setting [Flow Speed] and [Movement pixel].

You can select in the [Display Mode] menu whether to show the message of a new alarm immediately or to wait 

until the previous message disappears when a new alarm is issued.

2) Flow Alarm - Displays the text message corresponding to the alarm at the top, middle, or 

bottom of the screen when the conditions for the alarm are met.
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Once you configure the Flow Alarm Settings, you can see that the message corresponding to the alarm flows on 

the execution screen.

For each screen unit, you can set in its Screen Properties window whether to show the flow alarm when an alarm 

occurs. If you do not want to display the flow alarm in a certain screen, just uncheck the [Show Flow Alarm] 

option.
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3) History Alarm - Displays the alarm history when an error occurs on the connected device. You can check the 

status, reason, recovery time, and frequency of the error. Double-click [History Alarm] on the project window 

to display the settings window as shown below. Alarm back-up saves the alarm data stored in the NVRAM in 

external storage devices such as USB memory or CF card as a .CSV file or an encrypted file.

Select the external storage device that you wish to use in 

the [Back-up Data Location] drop-down menu. Back-up is 

performed when the device designated in the [Alarm 

Back-up] is on positive edge. When the file is saved, the 

Back-up Complete Device is set.

You can change the name of alarm back-up file by 

designating a device. Once the back-up is complete, you 

can send the back-up file to a designated e-mail address.

Once you set the [Area Deletion Device], alarm data 

stored in the NVRAM is deleted when the designated 

device is on positive edge. (Only the restored alarm data 

is deleted.)

You can check the number of current alarms in the 

[Number of Non-Recovered Alarms Device].

You can set the monitoring interval for the alarm device 

in the [Acquisition Cycle Timer]. You can change the 

acquisition interval as you wish. 

(Minimum value is 100 ms, but the screen refresh speed 

may become slow if the acquisition interval is too short.)
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You need to insert an alarm group to use a history alarm. Then, register the list of alarms in the alarm group. Create two 

alarm groups and register the list to each alarm group.

Enter the data type, number of alarms (maximum 10,000 per list), and address 

of the device that you want to designate as an alarm in the alarm list. Then, 

enter the text table and number of the message that you want to use as an 

alarm.

You can check the [Back up Alarm List] option to keep the previous alarm 

history when the XP is turned Off.

You can select in the [Edit Method] menu whether to set the device and text 

table as consecutive or individual.

Select [Show detail window] and designate the window number for each device. 

Then, the designated window appears on the execution screen when the 

relevant alarm has occurred. 

(Used to display the actions taken against the alarm.)

Use the [Reference Device] to designate the device that you want to refer to 

when the alarm occurs. This may help you find the cause of the alarm.
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In order to check the occurrence, recovery status, and details of the registered alarm, you need to add the [History Alarm 

Viewer] object to the screen. An alarm has three different statuses: occurrence, confirmation, and recovery. You can 

designate different color for each status. Insert the [History Alarm Viewer] object to the screen.

Select the number of lines and alignment to display the 

alarm in the Alarm Type menu. If you select [Latest], you 

will see the alarms that occurred most recently at the top 

of the object.

Specify the location, frame color, and line color and 

thickness of the Details window.

The [Initial Filtering Type] menu allows you to filter the 

[History Alarm Viewer] object when it is displayed on the 

execution screen. Check [No Restoration] to see the 

current alarms that are not recovered yet. Uncheck the 

option to see all alarms regardless of their status.

If you designate a certain group in the [Initial Alarm Group] 

option, you can only see the alarms of the group.

You can change the background color and text color for 

headers. You can designate background color and text 

color for each status of the alarm so that you can easily 

determine the status of alarm using the history alarm 

object.

The [Initialization Status] menu allows you to filter the 

[History Alarm Viewer] object when it is displayed on the 

execution screen. Check [No Restoration] to see the 

current alarms that are not recovered yet. Uncheck the 

option to see all alarms regardless of their status.

If you designate a certain group in the [Initial Alarm Group] 

option, you can only see the alarms of the group.
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You can select the column you want to display in [Edit Header]. You can also designate the time format for each alarm 

status. If you uncheck an item in the header, the corresponding column disappears in the execution screen. You can also 

change the location of the column that is displayed. Click on the column and drag it to the place where you want to place it.

If you use the [History Alarm Viewer] object for drawing, you can insert the related [Special Switch] and [Alarm Navigator] 

objects into the drawing, making your work more efficient. Use Delete All Restored Data, View Details Window, Check Data 

on Current Page, Page Up, Page Down, and Alarm Filter to make your own special switch. You can also make an [Alarm 

Navigator] and put it on the screen to display the name of the alarm group the alarm belongs to. Select the group name to 

display the alarms of the group in the [History Alarm Viewer] object.
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Logging saves the related device value on the NVRAM (non-volatile RAM) when the conditions for the device are met. 

Logging is generally used to track changes of the device of your interest and to analyze the cause of an accident as well. 

Logging number is assigned depending on the conditions and device. You can assign up to 32 logging numbers. Logging 

saves the data on an NVRAM space of 256 KB. You need to split the 256 KB memory appropriately to save each log.

1) Logging Settings - Double-click Logging on the project window to display the window as shown below. Double-click 

No. 1 Logging to display a dialog box where you can specify detailed settings for logging as shown at the right 

bottom of the screen.

 Default Logging Settings - Enter the address and number of devices that you want to save. Select either 16 bit or 32 

bit depending on the size of device.
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[Control Device] – You can control and check information on 

logging. You can use it only when it is necessary.

 Progress Indicator – Indicates whether the cyclic logging is 

on progress. It is not applicable when the conditional 

logging is set.

 Stop - Stops the logging currently in progress. Logging 

immediately stops when the entered device value is On.

 Area Full - When the area allocated for logging is all used 

up, the device turns On.

 Clear Area - When the device turns On, it clears the 

allocated area.

 Clear Area Complete - When the logging area is completely 

cleared, the bit turns On.

Logging Conditions - If you have selected the device you want to save, you need to define the conditions for logging. Logging 

conditions can be divided into cyclic logging and conditional logging. Cyclic logging requires the number of repetitions. 

Conditional logging executes logging depending on the status of a certain bit.

 Cyclic logging can be divided into logging by time and logging by device. If you select logging by time, logging is executed 

every interval you designate. If you select the number of repetitions, logging is repeated for the number of times you designate. 

If you select logging by device, logging is executed whenever the value of device changes. In this case as well, the logging is 

repeated for the number of times you designate.

 Conditional logging is executed whenever the value of designated bit device changes.

Note) If the logging is not performed for the preset number of times even if the conditions for cyclic logging are met, the logging 

conditions are ignored. For example, cyclic logging is set to be performed on positive edge of device M000 and number of 

repetitions is set to 3, and repetition interval is set to 10 seconds. In this case, if the M000 bit turns OFF → ON 5 seconds after the 

bit turns ON, positive edge on the M000 bit is ignored since the logging has not been performed 3 times.
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[Back-up] – You can set the logging back-up options.

 Back-up/Back-up Completion Devices – You can 

set the device that you want to start back-up on 

and the bit device that will be set after the back-

up.

 File Type – There are two types of files: a CSV file 

and an encrypted CSV file that is difficult to 

tamper with.

 File Name Device – You can enter the name of 

back-up file.

 Change the CSV file format – You can designate 

the header and number format of CSV file.

 Add Back-up to the End of CSV File/Number of 

Back-ups within CSV File – Generally, a new file is 

created every time back-up is performed. If you 

check this option, however, a new file is created 

only when the preset number of back-ups are 

written on the existing file.

Storage Area/Logging Back-up/CSV File Format – Back-up saves the logging data stored in the NVRAM to external storage 

devices (USB memory/CF card) in a CSV file format. Select the device that you want to save the back-up file on in the Back-

up Data Storage Location option. The back-up file is saved on the folder that is named after its logging number under the 

\Logging folder in the storage device.

 Use Cyclic Buffer on Storage Area - Record the new data while deleting the old data when the logging area is completely 

used up.

 Do Not Delete Storage Area during Back-up – If you uncheck this option, the data on the storage area (NVRAM) is 

deleted after the back-up. Therefore, you may lose all the logging trends and the data in the View Logging object.

 Automatic Back-up when the Storage Area Is Used up - Automatically backs up all the stored data to the designated 

storage device when the logging area is completely used up.
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Common Logging Properties – You can set the size of NVRAM for each logging number. (total: 256 KB)

Use – Check only the numbers that you want to use among 32 logging areas.

Size – Set the size of NVRAM for each logging number. (Use the function that calculates the size of logging.)

Calculate Logging Size – If you enter the size and number, and number of repetitions for device, logging size is 

automatically calculated.
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2) View Logging Object – You need to check whether logging is performed properly when the conditions are met 

after configuring the logging settings. View Logging object is used for this purpose. The View Logging object 

displays the logging number, time, and data in a table format.

[Default] Menu

 Logging Number – View Logging object displays the 

data based on the logging number. So, you need to 

enter the logging number.
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[Display] Menu

 Number of rows/columns - Specify the number of rows and columns for the table.

 Format - Designate the format for the logging time and the date/time format.

 Align - Specify whether to display the latest data or the oldest data on the top line of the View Logging object.

 Frame Shape – Specify whether to use frame and the color of frame.
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[Header] Menu

 Use Header – Specify the background and text colors for the header.

 Common Display Format – Specify the format of device value that will be displayed on the logging object at once.

 Edit Header – It is used to edit the header. If you wish to use multi-language function, select [From Header Text] 

to see the header in different languages. You can also edit the header manually. You can individually set the 

number of displayed items and the number of fractional digits.
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3) Logging Trend Object - It is used to check the logging data in a broken line graph. You can easily check the 

trend of data changes and drastic data changes through a graph. If you use the cursor and the clock object, 

you can easily check the logging time and logging data value. You can use the special switch that is linked to 

logging trend graph to move back and forth in time and see the trend.
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[Default] Menu

 Logging Display Type - Specify the data type 

that will be displayed in the logging trend.

 Maximum/Minimum Values – Specify the 

maximum/minimum values for the graph. 

Select Device if you want to change the value. 

Select Fixed if you want to fix the value.

 Alarm Value – Specify the highest/lowest 

values in addition to maximum/minimum 

values for the Y axis to indicate warnings.

 Logging Group – Select the logging number 

that you want to display in the logging trend.

 Display Priority – Select whether to refresh the 

graph with latest data.

 Display Condition – This option has two values: 

[Always Display] and [Display Depending on 

Conditions]. If you select [Display Depending 

on Conditions], the graph is displayed on the 

screen only when the conditions are met.

For example, if you set as shown on the left, index No. 1 and 2 graphs are 

displayed on the screen when HX0 and HX1 devices are On. You can use this 

function to display only the graphs that you need among many graphs.

 Add Device – If you enter the logging index that you want to show in the logging 

trend among the selected logging numbers, corresponding device address is 

displayed. Select the color and shape of line.
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[Display] Menu

 Number of X-axis Areas – Specify the number 

of areas you wish to divide the X-axis into. 

You can select Fixed to divide the X-axis into a 

fixed number of areas or select Device to 

divide the X-axis dynamically. If you select 

Device, you can expand/reduce the range of 

graph.

 Location of Origin – Specify origin to the 

location you desire among bottom left/top left 

and bottom right/top right of the graph.

 Screen Movement Unit – Specify how much 

you would like to shift the graph to the left 

when the graph reaches the end of the X-axis.

 Markings – Select the number of markings on 

the X-axis/Y-axis and the width and color of 

the marking.

[Reference Line] Menu

 Use Reference Line – Add reference lines with 

which you can check the Y-axis value of a certain 

point in the graph.
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[Cursor] Menu
 Use Cursor – If you touch the logging 

trend graph on the XGT Panel, a vertical 
cursor appears. If you touch it once more, 
the cursor disappears. If you use the 
cursor, you can check the logging data 
value and time data for the location 
where the cursor is placed. Select [Save 

Cursor Information] and designate a 
device. Then, the trend graph information 
of the location where the cursor is placed 
is saved on the designated device.

You can use the clock object as shown on 
the figure to the right to see various time 
data of the logging trend.

Time
Data

Time
Data

Data per 
index
(maximum 
32)

Data per
index
(maximum 
32)

- Device Structure for Saving Cursor Information
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You can use recipe to save large amount of process data on the XGT Panel and import the required process data 

block to the PLC at the time you desire. If several product models are manufactured on one facility, manufacturing 

process may be the same, but the operation data may vary depending on the product. If you use the recipe, you 

don't have to change the data every time each product is manufactured, allowing easy processing of the data.

There are two types of recipes depending on the data storage: default recipe and file recipe. Default recipe uses 

the XGT Panel internal memory to store the data. File recipe uses the CSV file format to read and save the data. 

You can edit the file recipe on XP-Builder and download and save it. Or, you can also save the CSV file directly on 

portable storage devices (USB memory/CF card).
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 Write Block Data - If the writing start device is on positive or negative edge, recipe data are written consecutively 

to the device in the PLC starting from the designated device address as much as the preset number of devices.

 Read Block Data - If the reading start device is on positive or negative edge, recipe data is read to the XGT Panel 

consecutively starting from the designated device address in the PLC as much as the preset number of devices.
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 Writing Start Device - Specify the address and conditions (positive and negative edge) for the device that will control the 

writing start operation.

 Reading Start Device - Specify the device that will control the reading start operation.

 Recipe Number Designation Device - Specify the word device that designates the number of recipe to be executed when 

the reading or writing start device meets the conditions.

 Block Number Designation Device – Specify the data block that will send the data in the recipe to be executed when the 

conditions are met. It is a word device that sends data from device to device. Block number designation device is only 

valid when the default recipe is executed.

It is ignored when the file recipe is executed. (File recipe can use only one block data.)

 Recipe Type Designation Device - Specify the type of the recipe to be executed when writing or reading device conditions 

are met. When the lowest bit for recipe type designation device is 0, default recipe is executed. When the bit is 1, file 

recipe is executed.

 Default Recipe Storage Location - Specify the memory that you want to save the default recipe data on. If it is a SRAM 

memory, the data is saved on the memory, not as a file. If it is not a SRAM memory, the data is saved as a file on the 

memory. When it is saved as a file, you can use the recipe of up to 1 MB size.

 File Recipe Storage Location - Specify the path where the data file for the file recipe is saved. You can specify a CF card or 

USB memory.

 Back-up Data Storage Location - Specify the back-up location where you want to back up the recipe data. It is the same as 

the recipe data back-up location in the [Storage Device Usage Settings] from the Project Properties menu.

 Sending Complete Device - When the recipe is executed and the data transfer is complete, the corresponding bit changes 

to On.

 Error while Sending Device - When the recipe is executed but an error occurs while sending the data, the corresponding 

bit changes to On.

 Back-up Start Device - Starts the back-up of the recipe data on portable storage devices such as USB memory or CF card.

 Back-up Complete Device - When the back-up is complete, the corresponding bit changes to On.

1) Recipe Settings
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 On the Recipe menu in the project window, right-click Default Recipe and select Insert to create a 

default recipe. Recipe is given a unique number when it is created.

 Device – Specify the address of the device that you want to use for reading and writing the recipe.

 Number of Devices – Enter the number of devices that you want to allocate to one data block.

 Data Type – Select the type of an individual device.

 Number of Data Blocks – Enter the number of data blocks that you want to register in one recipe.

Enter the process data values in the relevant device of each block in advance as shown below.

2) Default Recipe
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Let's make a drawing as shown below to check whether the recipe is being executed properly.

① Create one number editor (D2000). Then, increase the number of devices with consecutive copying to make 100 number 

editor objects.

② Add the relevant number editor to the recipe number (HW10) and block number device (HW11).

③ Create a bit switch for the recipe writing device (HX000) and set the operation type as [On Only When Pressed].

④ Create a bit switch for the recipe reading device (HX001) and set the operation type as [On Only When Pressed].

Send the recipe data to the XGT Panel and perform reading/writing by changing the recipe and block numbers.
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Script is used to write the function user wants into a sentence. Generally certain actions are assigned to objects to 
compose a screen. However, if you wish to control a certain event without touching the screen, script is often used. 
When you write a script to implement the function that you want, you need to enter the conditions for executing 
the script.

 You can easily maintain the system by using the script.

 You can control a screen in various ways by using the script.

 You can use various functions.

 You can easily process complicated arithmetic operations.

 It supports an easy-to-use programming language. (Limited C language)

 It supports programming editors that are generally used.

 You can execute each script conditionally.

 You can check the syntax of the script you created.

 You can specify various conditions to execute the script.

 You can send and receive data to/from the controller by using a custom protocol driver. (Custom 

communication is available.)

1) Advantages of Script

 Register a global script to execute it.

 Register a screen script to execute it.

 Execute a script when the screen is opened or closed

 Register a script in an object-controlling item to execute it every time communication is performed.

 Register a script in a word switch to execute it when you touch the switch.

Chapter 11. Special Functions



122

If you want to create a script, right-click Script and select Insert to display the Edit Script window on the right.

Select [View] ->[Script Tool Window] to display the list of functions and control statements that can be used for script 

as shown below. Use the functions and control statements to implement the function user wants.

To insert a PLC or HMI device when writing a script, type @[Data type:Channel number:ID:Device address].

(Ex. @[X:P0000], @[W:0:#1:D0], @[D:1:%MW000])  

You can select data type among X (bit), W (16 bit without sign), S (16 bit with sign), D (32 bit without sign), L (32 bit 

with sign), and F (real number) depending on the range of value you desire.
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Once you wrote a script, you need to set the conditions for executing the script.

You can use a global script, screen script, word switch, or object control to execute the script.

Global Script Screen Script

Word Switch Object 
Control

This script is executed when the conditions are met regardless of 

the screen you control or monitor in the project.

This script is set for each screen and is executed only when 

the user is monitoring the corresponding screen.

You can assign a script to the word switch. The script is 

executed when you press this switch.

This script is executed every time communication is 

performed in a screen that displays the object.
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Let's create some simple scripts for practice.

- Turning off the backlight

- Using a buzzer

- Setting off a buzzer

- Switching to No. 2 screen

- Increasing a device by an 

increment of 1 and resetting it to 

0 when it reaches 400

- Setting off the buzzer when a 

certain bit changes to ON
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Chapter 12. Convenience Functions

In this chapter, we are going to look into convenience functions that can be used in the XP-Builder. You can change the 

name and properties of an object in the property window.

If you use a property window, you can change various object properties all at once, instead of modifying them one by one.

1) Creating a Property Window

Press [Property Window] in the [View] menu to add a window.

2) If you want to modify several objects using the property window, you need to select 

the same type of objects. For example, if you select a bit object and word object, 

properties are not shown on the property window. If you want to modify several bit 

lamps all at once, you should only select bit lamps.
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Memo pad can be used to leave a memo to the next worker or save 

the work details.

1) General Settings

 Select [Memo Pad] on the object tool box.

 Paste the pad on the Edit window in a size you want.

2) Using a special switch to use a pen or the Delete 

function

 Execute [Special Switch] on the object tool box.

 Select the function you want from the [Memo pad] tab to 

store or delete a memo or select a pen.

 You can save the memo by specifying the location you want 

to save the memo file in [Project Properties] - [Storage Device 

Usage Settings].
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XP-Builder can be linked with XG5000, a PLC control program by LS Industrial System, on the PC.

Select [Use XG5000 Simulator].

(1) Select [Tool] -> [Start Simulator] in XG5000. (2) Select [Project Properties] -> [Device Settings] -> 
[Simulator Settings] in XP-Builder.

(3) Start the Simulator in XP-Builder. (4) Control/Monitor XG5000 simulator data in the 
XP Simulator screen.
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XP-Server can collect data from XGT Panels in the production site to the PC at the time you want and save in a format such 

as Excel, Microsoft Access, SQL Server, and CSV. XP-Manager is a PC software that is used to configure the data exchange 

between XP-Server and XGT Panels (XP-Link), send an e-mail, connect to the database, and use various utilities.

In this chapter, we are going to learn how to install and manage driver using the XP-Manager.

1) Installing XP-Manager

 Download the XP-Manager from our website and install it on the computer.

 You can install the driver for the remote monitoring program and connect to it in the XGT Panel by using XP-

Manager.

2) Installing the Program

 Drivers for VNC or Web Server are not installed in the XGT Panel since the storage capacity of XGT Panel is limited. 

So you need to install them through the XP-Manager.

 You need to connect the XGT Panel to the Ethernet to see its IP address.

 Right-click the IP address to display the window as shown below.

 If you select Driver Management to display a new window. In this window, you can install the driver.
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1) Installing VNC Driver on the XGT Panel

 Install driver in the XGT Panel through XP-Manager.

 Select the flash memory for the Location to Download. Press 

the Configure button to start installation.

2) Executing the Program

 Once the driver is installed in the XGT Panel, execute the 

VNC program in the PC.

 Enter the IP address of the XGT Panel that you want to 

connect to on the XP-VNC (a PC software) and connect to 

the XGT Panel. Now, you can control and monitor the 

screen displayed in the XGT Panel using your PC.

 You can configure the XGT Panel to prevent it from being 

controlled in the PC while you operate the XGT Panel in the 

production site (VNC interlock device is provided).

 You can only connect to the XGT Panel that is being 

operated by the VNC server.

 You can monitor and control several XGT Panels in one PC 

(no limit to the number of XGT Panels that can be 

connected to).

VNC allows you to see the screen displayed on the XGT Panel in your PC. Screen images are brought to the PC through the 

Ethernet, so the screen refresh speed is slightly slow.
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1) Installing the Driver for XP-Remote Viewer
 Download the XP-Remote Viewer from the LS Industrial System website 

to install it.

2) Executing the Program
 Execute XP-Remote Viewer on your PC.

 Press Search and connect to the IP address of the XGT Panel that you 

want to connect to.

 First three letters of the IP addresses of your PC and the XGT Panel 

should be the same to establish communication.

 If the first three letters are different, you need to check [1:1 Connection 

when Connecting to XGT] in [Tools] - [Options].

 If you press the empty space on the XGT Panel for three seconds, a 

menu bar appears. Press the 'enable control by XP-Remote' at the 

bottom right to provide control permission to the PC to operate and 

control the XGT Panel on your PC.

 You can connect to one XGT Panel from up to 4 PCs using XP-Remote 

Viewer. (Not possible in XP-VNC)

 You can upload a project from the XGT Panel or open a project file 

(.XRT) that was saved previously to monitor the XGT Panel.

 If the remote control permission is allowed, you can control the XGT 

Panel only in one XP-Remote Viewer. You cannot control the XGT Panel 

with another XP-Remote Viewer until the permission is returned to the 

XGT Panel.

XP-Remote Viewer function, unlike the XP-VNC, can display the current screen of the XGT Panel in your PC by using data 

communication, instead of using screen image transfer. If you give control permission to the PC in the XGT Panel, you can control 

the XGT Panel in your PC.
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Operation Log function can be used to save XGT Panel’s operations. Any operation used in XGT Panel can be checked. With 

operation log, it is possible to analyze cause of problems.

※ Operation Log is only available in iXP Series.

 If [Operation Log Condition] is ‘Any time’, it will save the log data all time. If 

[Operation Log Condition] is ‘On Bit ‘ON’, it will save only when the selected 

bit is ON.

 [Status Device] is a word device to monitor log operation.

 When selected [NVRAM Del Device] is at rising edge, alarm data saved in 

NVRAM is deleted.

 If [Operation On NVRAM Full] is at ‘Stop’, operation log will stop when 

NVRAM is full. If ‘Using Ring Buffer’, it will save new log by deleting the 

oldest file.

 Check on [Operation].

 Select a device to trigger the backup in [Backup Device]

 Select [Automatic backup on NVRAM Full] if automatic backup is needed when 

NVRAM is full.

 If [Append Backup content at same file] is checked, new backup data will be saved at 

the end of previous backup file. Each file can save maximum of 1024 logs. If it is not 

checked, new backup data will be saved into a new file.
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